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Adobe® Illustrator® CS2 puts industry-standard drawing tools at designers’ fingertips so 
that they can create graphics for print, video, the web, and mobile devices with ease. And 
now, with the new Live Trace feature, Illustrator CS2 offers an entirely new way to create 
vector graphics. Live Trace, a breakthrough tracing tool, lets you convert scanned line art 
and bitmap images to scalable, editable vector paths and anchor points in just seconds.

How many times have you roughed out an idea on the back of a paper placemat, only to 
have to recreate your work from scratch on the computer? How often have you wished 
you could scan a photograph and convert it directly to a vector graphic as the starting 
point for an illustration? With Live Trace, you can do both—and more.

What makes Live Trace “live” is a link that is maintained between the original bitmap 
image and the traced vector result. You can experiment with tracing options ranging 
from aesthetic to technical, from color swatches to pixel value thresholds. The traced 
result updates automatically, even if the original linked bitmap file is modified. Not 
only is Live Trace live, it’s also intelligent—its choice of the total number and placement 
of anchor points rivals that of the most skilled Illustrator artist.

This white paper is intended for graphic designers, art directors, freelancers, web designers, 
print and prepress professionals, and others who are involved in the day-to-day, hands-on 
creation of graphic materials for print, the web, and mobile devices. It explains how Live 
Trace works and how you can use it to achieve a high-quality vector foundation on which 
to build your creative artwork.

About vector tracing
In the world of computer graphics, there are generally two types of image files: bitmap 
and vector. Vector tracing is the process of converting resolution-dependent bitmap 
content into resolution-independent vector content. There are many uses for bitmap to 
vector conversion and reasons why it’s needed in a design workflow.

Bitmap images, also referred to as raster images, are made up of a collection of dots 
or pixels in a grid. Because bitmap images can produce painterly effects, they can be 
photographic in nature. Bitmap images are defined by the number of pixels in the image 
(called resolution) and the number of colors contained in the file (called bit depth). 
The ability to capture, manipulate, and display images in digital form has dramatically 
increased the amount of content that exists in bitmap form. Files that are saved as PSD, 
JPEG, GIF, TIFF, and BMP are all examples of bitmap file formats.

The resolution of a bitmap file is usually measured in pixels per inch (ppi) and is set when 
the image is created. For example, when you take a digital picture, scan a piece of art, 
or create a digital painting, you define what the resolution of that image will be. If an 
image has a high resolution, the individual pixels are smaller and, hence, give the image 
a greater level of detail. In extremely low-resolution images, the individual pixels might 
even be large enough to see, resulting in stair-step patterns, also known as jaggies. When 
bitmap images are enlarged, the pixels are just made larger. For example, if you take a 
300 ppi image and enlarge it 200%, the effective resolution of the file is 150 ppi.
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The color depth is also set at creation time and is usually measured in bits. For example, a 1-bit 
image can contain two colors: black and white. An 8-bit image can contain up to 256 colors, and 
a 24-bit image can hold 16 million colors. High-resolution images with a high bit depth can be 
extremely detailed.

Bitmap images look great at actual size, but begin to deteriorate in quality as they are scaled 
upward in size or manipulated. While bitmap images are perfect for photographs and digital 
paintings, they are less than ideal for logos and illustrations, which need to be rescaled for differ-
ent uses. Additionally, bitmap images have softer edges on text and lack the crisp lines that are 
necessary for text and certain art styles and projects.

In contrast, vector images are made up of paths, called bezier paths, that are defined mathemati-
cally. These paths were originally developed for designing cars and airplanes. The paths use anchor 
points and control handles to define the position and behavior of paths on an x,y axis, which gives 
you the ability to create free-flowing shapes that are clean and sharp. Because the anchor points on 
these paths are defined as mathematical coordinates, they are resolution-independent and can be 
scaled to any size without losing quality or appearance. In addition, working with distinct objects 
and paths makes it easier to create and edit artwork. For these reasons, vector images are perfect for 
logos, maps, and other artwork that must remain in a scalable and nondestructive form

The image on the left is a 100 ppi bitmap scaled to 300% and has jaggies. The clean and smooth image on the 
right is vector art scaled to 300% of its original size.

If you want to take bitmap artwork and scale it up in size, enhance or sharpen the art’s appear-
ance, or perform other edits that require the art to be in vector rather than pixel form, you must 
perform vector tracing. Vector tracing is also necessary if you want to resize or edit scanned 
artwork, since scanners create bitmap image data. Low-resolution images, which can’t be repro-
duced at large sizes, as well as photographs or images taken with a digital camera also need to be 
traced if you want them in vector form.

How vector tracing works
Vector tracing takes a bitmap image and creates vector paths to closely match the lines and 
shapes in the bitmap image. The result is a version of the original artwork that is easier to 
edit—and more importantly—can be scaled to any size.

There are other products or plug-ins that perform this conversion, but they are expensive and 
don’t give designers the results they need. For example, designers can spend a considerable 
amount of time editing a scanned image or photograph in an image-processing application, 
such as Adobe Photoshop®, to deliver optimal tracing results. This process requires an in-depth 
understanding of tracing technology and how to best prepare the image. In addition, extra work 
is often needed to add anchor points and fix imperfect paths and irregularities caused by the 
tracing process. Many experienced designers avoid automated tracing because they feel that 
they can produce better results and more efficient paths. Of course, this more manual process of 
tracing art by hand can be extremely time-consuming, usually entailing hours of detailed and 
complex work.

Live Trace in Illustrator CS2 takes all of these challenges into account and presents an elegant—and 
efficient—solution. Because Live Trace is completely integrated into Illustrator CS2, it requires 
no additional software, plug-ins, or investment. Live Trace takes a comprehensive two-step 
approach to converting bitmaps to vectors. In the first step, Live Trace “conditions” the bitmap 
image for optimal tracing, making adjustments to tone, resolution, and color. In the second step, 
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Live Trace draws vector paths, taking advantage of technology that creates highly accurate and 
professional vector art. But this two-step process is only half the story. By keeping the original 
bitmap image and the traced vector result linked together (hence the name, Live Trace), you can 
adjust the bitmap conditioning settings and the vector tracing settings individually, and preview 
the results immediately. So you can tweak the results of your designs easily and without disrupt-
ing your creative workflow.

Live Trace performs several steps to produce high-quality results. After the original bitmap is placed into  
Illustrator (1), Live Trace conditions the bitmap image (2), and then traces it with precision (3), resulting in a  
Live Trace object that can be tweaked to perfection (4).

Basic terminology
Vector tracing has its own terms. You might want to familiarize yourself with the terminology, 
since it will be used throughout this document.

Fill tracing A style of vector tracing that uses filled objects to better simulate the natural thicks, 
thins, and curves of a drawing. Also referred to as outline tracing.

Stroke tracing A style of vector tracing that produces vector paths with stroke attributes rather 
than closed filled shapes. The paths produced throughout the entire trace have varying thick-
nesses to best match the original bitmap image, but each path itself has a single straight line of 
even and consistent thickness. This method is also referred to as centerline tracing.

Black and white images Also called 1-bit images, these bitmaps only contain pixels that are col-
ored white or black. The Black and White setting in Live Trace produces vector art that is colored 
either black or white.

Grayscale images These 8-bit images support up to 256 levels of gray and represent photo-like 
quality. The Grayscale setting in Live Trace produces vector art that is colored with up to 256 
different shades of gray.

Color images Images with color can contain up to 32 million colors, using a bit depth of up 
to 32 (sometimes called TrueColor). The Color setting in Live Trace produces vector art that is 
colored with up to 256 different shades of color.

Posterization When making contrast adjustments in an image, it’s entirely possible to lose 
subtle gradations of color or detail where contrasting colors meet. Photographic images often 
have thousands, if not millions, of colors. To trace such an image, the photo must first be reduced 
to reference a smaller number of colors. This reduction causes a noticably pronounced and 
abrupt shift in color, called posterization.

Blur A method of smoothing the pixels in a bitmap file. A blur removes detail from an image by 
reducing the number of high-contrast pixels in an image.

Threshold In multibit images, pixels might vary between black and white levels, or between 
colors used in a library. The Threshold setting determines whether intermediate pixels lean 
toward being traced as black art or white art. Threshold is only used when art is traced for black 
and white output.

Resampling Bitmap images are made up of a specific amount of pixels, which define the resolu-
tion of the image. Resampling changes the number of pixels in a bitmap image. Upsampling  
adds more pixels to an image. New pixels are added using a variety of interpolation methods. 
Downsampling removes pixels from an image.
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Minimum area In the process of tracing, Live Trace looks for collections of pixels to convert 
into vector form. However, tiny areas of pixels might be the result of a noisy or dirty scanned 
image, resulting in a level of detail that is not desired. The Minimum Area setting determines 
how large a collection of pixels must be to be considered viable for conversion to vector. Any col-
lection of pixels that falls beneath this setting is considered noise and is not traced.

Preset A stored or saved collection of option settings for a specific feature. The Live Trace 
feature in Illustrator has many different settings. Live Trace enables you to create and save your 
own tracing presets, or to quickly trace an image with one of the 13 image-specific presets that 
are built into the feature.

Expand Once a bitmap has been traced with Live Trace, Illustrator maintains a live link 
between the original bitmap image and the resulting vector paths, allowing for tweaking of the 
settings and minor adjustments. However, you do not have direct access to the actual anchor 
points and paths for editing. Once an image has been traced and you are happy with the results, 
you can expand the results, which permanently applies the trace. You can then edit the resulting 
vector paths. The original bitmap image is discarded, and tracing options are no longer available 
for the resulting vector paths. Expanding a Live Trace object is similar in concept to expanding a 
pattern, gradient, blend, or appearance.

Choosing a source image
Live Trace is much more than a simple conversion tool. Rather, it can redefine how creative 
individuals use Illustrator and computers to create their work. Whether you like to start with a 
pencil and a sketch pad, a pressure-sensitive pen tablet, or a digital camera, we’ll go through the 
steps of using Live Trace in Illustrator CS2 to turn those concepts into final art with professional 
results. You can take advantage of Live Trace to best match your needs. Experiment with results 
that look more hand-drawn or tweak for a more crisp and clean “computer-like” style.

Choosing the right source image can have a substantial impact on the quality of the resulting 
traced object. Likewise, when creating a sketch or drawing that will eventually be traced, there 
are general techniques and considerations you can apply to enhance the final result.

Traditional drawing methods
In today’s digital age, many traditional artists might feel at a disadvantage if they aren’t familiar 
with drawing their designs directly on a computer, using either a mouse or a pressure-sensitive 
tablet. There is certainly no substitute for drawing with traditional tools such as ink on paper, 
and with Live Trace, there’s no need to throw away those valuable tools. Artists are now free to 
create art as they wish and then scan and trace their work to complete it in digital form while 
still preserving their creativity in the process. While marker or ink pens on heavier paper might 
produce better tracing results, artists can use pencil and tracing paper, although such drawings 
might require more adjustments after being scanned and before tracing them in Illustrator. Live 
Trace works with bad source images. The main deterrent to getting a clean traced image is a scan 
that is very noisy. Images with noise contain artifacts that degrade image quality. The cleaner the 
image, the better the traced result.

Scanning techniques
Scanners come in all shapes and sizes. Professional models support higher color bit depths and 
higher resolutions, however, those capabilities aren’t needed for many tracing purposes. A simple 
flatbed scanner that can capture sketches cleanly with little noise works well. Another consider-
ation is how large an original you can scan, since the maximum size the scanner can handle dic-
tates the largest size paper you can sketch on. With Live Trace, a higher resolution scan doesn’t 
necessarily translate to a better traced result. In many cases, a high-resolution file adds complex-
ity to a traced file and significantly affects performance.

Some design workflows might require better scanners that can capture more detail in the bitmap 
image. Sometimes this additional detail can act as noise and get in the way of producing a good 
tracing result. Scanning at high resolutions might require that you reduce detail and lower the 
resolution of the source image after scanning. Live Trace has several tools to help adjust images 
in the bitmap conditioning stage.
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Digital painting
Some artists have found that using a pressure-sensitive pen tablet and Photoshop lets them 
express their creativity directly on their computer. Because the art is typically clean and free of 
noise, you can expect clean results from tracing these kinds of images.

Digital photography
You can import digital photos onto your computer and place them directly into Illustrator for 
tracing. Because of the lossy JPEG compression used in most digital photographs, these images 
often have noticable artifacts, which might contribute to additional noise. It might be helpful to 
use a photo editor like Photoshop CS2, which contains a noise reduction filter that can specifi-
cally clean up JPEG artifacts, to better prepare these images for tracing in Illustrator. See the 
section “Edit Original and Adobe Photoshop CS2” for more information.

Bringing an image into Illustrator
In Illustrator, you can usually perform a particular task in several different ways, with each 
method having its own benefits or strengths. Working with bitmap images in an Illustrator 
document is no different. You can place an image into any open Illustrator document by choos-
ing File > Place. Illustrator supports two kinds of placed images: linked and embedded. A linked 
image maintains an external connection to the original file. Linked files must be included when 
sending the Illustrator file to other users. Linked images don’t add any significant file size to the 
document. In contrast, embedded images lose their link with the original file when the image is 
placed. Embedded images become part of the Illustrator file, and the external file is not needed 
when transferring the Illustrator file to others.

Place-Link Place-Embed

Requires external link Yes No

Adds to file size No Yes

Can be updated easily with Edit Original feature Yes No

Live Trace can auto-detect resolution of file Not always Yes

Multiple placed images can be updated at once
*Unless the embedded image is first defined as a symbol.

Yes No*

The pros and cons of using placed-linked images and placed-embedded images in a workflow.

Once you’ve brought a bitmap image into Illustrator CS2, you can convert the image to vector paths 
using Live Trace, accessed through a new Illustrator CS2 feature called the Control palette. This 
context-sensitive palette stretches across the top of the screen and offers convenient access to nearly 
80% of Illustrator’s feature set, alleviating the need to clutter your screen with multiple palettes.

Tracing an image 
To trace the selected image using the default preset, click the Live Trace button. Alternatively, 
click the tracing preset icon and choose from one of the following presets.

Default A simple black and white preset designed to get you started quickly.

Color 6 For tracing color logos and simple illustrations.

Color 16 For complex color logos and more advanced illustrations. Can also be used to acheive 
stylized posterized illustrations.

������������������ ���������� ������������������ ������������

��������� ������������������� ����������

When you select any bitmap image, the Control palette changes to display several image-related functions.

Photo Low Fidelity For tracing photographic content where detail isn’t important.

Photo High Fidelity For tracing photographic content where detail is important.

Grayscale For tracing art or images where a monotone gray result is desired.

Hand Drawn Sketch For converting hand-drawn sketches into vectors.
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Detailed Illustration For converting illustrations with fine lines and detail.

Comic Art For tracing art in a style often found in comic books and strips.

Technical Drawing For maps and highly technical drawings.

Black and White Logo For converting simple solid line art for logos.

Inked Drawing For tracing inked drawings.

Type For converting bitmap text objects into vectors.

������������������ ��������� ������������ ������ ���������� ������������

���������������������������������������������� ��������������������

Once you’ve traced an image, the Control palette changes to present different options.

Note: When tracing images using Grayscale or Color mode, the Max Colors setting replaces the 
Threshold setting in the Control palette.

In this live state, you can continuously make adjustments to the trace settings, and the results 
update automatically. You can’t actually edit the vector paths just yet, since Live Trace maintains 
a live link between the bitmap image and the traced result. To access the paths, you have to either 
expand the trace or convert it to a Live Paint group, both of which we will discuss shortly. How-
ever, you don’t have to expand the paths at all if you’re happy with the trace results. Live Trace 
objects will RIP and print correctly as vector shapes.

Artboard view options
Illustrator offers several different ways to preview a Live Trace object. Once a trace has been 
completed, two icons in the Control palette become active: one controls how the bitmap image is 
previewed, and the other controls how the resulting vector object is previewed. You can set these 
preview settings independently.

Preview Raster Image
The No Image setting completely hides the bitmap image from the display (and is the default 
setting). The Original Image setting displays the original bitmap image in your document, which 
might be helpful to use when comparing the original image to the traced result. The Adjusted 
Image setting displays the bitmap image as it appears after Live Trace has applied the preprocess-
ing conditioning adjustments. This preview mode is great for seeing how Live Trace works and 
makes it easier to preview adjustments you make to the bitmap image settings. The Transparent 
Image preview mode displays a dimmed preview of the bitmap image beneath the traced result, 
enabling you to better see the traced results when comparing them to the original bitmap.

Preview Vector Result
The No Tracing Result setting hides the traced vector objects from the display. Additionally, 
this setting disables the actual vector tracing and is extremely useful when used in tandem with 
the Adjusted Image raster preview setting, allowing you to experiment with different bitmap 
conditioning settings and preview them without taking a performance hit each time while waiting 
for Live Trace to calculate the results. The Tracing Result setting displays the vector result of the 
tracing (and is the default vector setting). The Outlines setting displays the resulting bezier paths. 
The Outlines With Tracing setting displays those same paths as semi-transparent, enabling you 
to compare filled areas of the traced vector result with the original bitmap image. The color of the 
outlines displayed matches the color specified for guides in the document preferences.

Fine-tuning your results
Once you have traced an image, you can tweak the Live Trace settings to perfect your results. 
First, you can quickly choose between the different Live Trace presets to preview your art.  
(We will discuss how to create your own custom presets later in this document.) In the Control 
palette, you can use the Threshold, Max Colors, and Minimum Area settings to alter the results 
of your traced object. 
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The Threshold setting determines the boundaries between pixels when using the Black and 
White trace setting. For example, in a gray bitmap, a high threshold setting results in more gray 
pixels becoming black vector objects. In that same image, a low threshold setting results in more 
gray pixels ignored, making for more white-colored objects. When using the Black and White 
setting to trace color images, Threshold defines which colors appear as black or white in the final 
traced result.

1. The original bitmap image. 2. Threshold set to 80. 3. Threshold set to 128 (Live Trace default). 
4. Threshold set to 200.

The Max Colors setting determines the maximum number of colors that can be used in the final 
traced result when the Grayscale or Color trace setting is used. Live Trace uses the Selective color 
reduction method to reduce the number of colors in the bitmap to match this setting during the 
bitmap conditioning process.

� � � �

1. The original bitmap image. 2. Max Colors set to 4. 3. Max Colors set to 16. 4. Max Colors set to 48.

One of the most common issues with tracing images is dealing with noise in an image. Live 
Trace does a great job in turning each and every pixel into vector objects, but many times that’s 
just too much granularity. The Minimum Area setting sets a threshold for how large a piece of 
artwork must be to be converted to a vector object. For example, you might not want to see a tiny 
2-pixel by 2-pixel speck in your traced result. By setting a minimum area, you can instruct Live 
Trace to only trace collections of pixels that meet a minimum size. If the Minimum Area is set 
to 9 pixels, Live Trace ignores regions of pixels that are less than 3 by 3 pixels in size. In this way, 
you have a result that is much cleaner in appearance, isn’t as complex, and is easier to work with.

1. Original bitmap image. 2. Minimum Area set to 10 pixels (Live Trace default). 3. Minimum Area set to 5 pixels. 
4. Minimum Area set to 0 pixels.
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Converting traced images to classic Illustrator paths
Live Trace maintains a live link between the bitmap image and the traced vector result, which 
enables you to tweak and modify the images and have Illustrator automatically generate a new 
result. Once a trace is complete and you’re satisfied with the result, you might want to edit the 
bezier paths, delete portions of the image, or apply your own custom coloring.

To convert a Live Trace object into classic Illustrator paths, you must use the Expand feature. 
With a Live Trace object selected, click Expand in the Control palette. You can then use the 
Direct Selection tool to edit anchor points and bezier paths. At this point, the traced object is 
no longer live or linked to the original bitmap image, which has been discarded from the file. 
The traced result is now permanent and can no longer be adjusted using any of the Live Trace 
options. Once a Live Trace object is expanded, you have complete freedom to use and apply any 
of the Illustrator editing tools and effects.

Once the Live Trace is expanded, you can edit each of the individual paths as you would any vector object.

Tip: If you are tracing a bitmap and know that you are going to immediately expand it for further 
editing, you can press the Option key (Alt key on Windows) while clicking on the Live Trace button 
or choosing a Live Trace preset from the Control palette to both trace and expand in one step.

Converting traced images to Live Paint groups
The new Illustrator CS2 Live Paint feature lets you color artwork quickly and intuitively—almost 
as if you were coloring inside the lines of a coloring book. Once you’ve converted paths to a Live 
Paint group, you can use the Live Paint Bucket tool to apply color anywhere you want. The art 
that is created in a Live Paint group is represented in a flat world in which intersecting paths 
define paintable areas: what looks like a paintable area is a paintable area. No need to painstak-
ingly plan and create objects just to carry color—instead, you can dive right into coloring.
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With a Live Trace object selected, click the Live Paint button in the Control palette, which expands 
the trace and converts all of the resulting vector objects into a Live Paint group in a single step. You 
can then select the Live Paint Bucket tool to fill your art with color without any additional steps.

All objects within a Live Paint group exist on a single flat layer.  
Moving the Live Paint Bucket tool over a Live Paint group highlights paintable regions.

One of the more powerful features of Live Paint is Gap Detection, which lets you fill areas that 
are not completely closed, either as a result of the style of the illustration or the tracing process. 
Gap Detection is available by selecting a Live Paint group and clicking on the Gap Options icon 
in the Control palette. Alternatively, you can choose Object > Live Paint > Gap Options.

When you use the Live Paint button to convert a Live Trace object directly to a Live Paint 
group, Gap Detection is deselected by default. Selecting Gap Detection can significantly impact 
painting performance if you are working with a complex tracing result. The number of objects 
in a Live Paint group can also slow down performance, so in large complex groups with many 
objects, you might get better performance by first expanding the trace and then creating several 
smaller Live Paint groups rather than one large group.

If you prefer to do inking by hand and then scan and trace the results, the Live Trace to Live 
Paint workflow makes it easy to apply color as a last step rather than try to scan and trace colored 
drawings.

For more information on the Live Paint feature in Illustrator CS2, go to the Illustrator CS2  
product page at www.adobe.com/products/illustrator.

http://www.adobe.com/products/illustrator
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Tracing options
The Tracing Options dialog box offers a wealth of settings to perfect a trace. You can access the 
Tracing Options dialog box via the  icon in the Control palette (when a tracing object is tar-
geted) or by choosing Object > Live Trace > Tracing Options.

The Tracing Options dialog box in Illustrator CS2 enables you to tweak Live Trace objects to perfection.

Note: All settings in the Tracing Options dialog box (including vector settings) use pixels for mea-
surement, since the only reference is the original source bitmap image.

The Tracing Options dialog box gives you full access to the two-step process that Live Trace 
uses. The Adjustments settings on the left side of the dialog box apply to the conditioning of the 
bitmap image before the image is traced. The Trace Settings determine how the vector tracing is 
performed on the image.

Adjustments
Live Trace converts a bitmap image to either 1-bit black and white, 8-bit grayscale, or 8-bit color, 
which you can choose from the menu. If you choose Black and White, you can specify a thresh-
old value. If you choose Grayscale or Color, you can specify the maximum number of colors for 
Illustrator to use for tracing. If you select Output to Swatches, Live Trace creates global process 
color swatches for all of the colors used in the traced result, which makes it easy to use those 
colors for other vector objects in the file.

By default, Illustrator uses the selective color reduction method to choose the best colors to fit the 
image (based on the Max Colors value). Alternatively, you can choose specific colors to use when 
tracing an image, enabling you to change or edit colors without expanding the Live Paint object. 
First, you must load a custom swatch library by choosing Open Swatch Library from the Swatches 
palette menu. Then, in the Tracing Options dialog box, choose the custom library from the Palette 
menu. You can also sample colors directly from the bitmap to build your own custom library of 
colors. Choose the Eyedropper tool and press the Shift key while clicking on regions of the bitmap 
to sample colors. Use the Swatches palette to save the colors as swatches, and then save a custom 
swatch library by choosing Save Swatch Library from the Swatches palette menu. Experimenting 
with different custom swatch libraries can yield stylized and creative results.

The Blur setting applies a Gaussian Blur to the image, which helps remove noise from a bitmap 
and might ultimately reduce the number of anchor points in the tracing result, especially when 
tracing photographic content. Blur also helps smooth out rough edges.

1. The original bitmap image. 2. Blur set to 0 pixels. 3. Blur set to 1 pixel. 4. Blur set to 2 pixels.
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The Resample setting lets you change the resolution of the bitmap image to help obtain a better 
traced result. Resampling a bitmap image at a lower resolution greatly enhances the speed per-
formance of Live Trace. Alternatively, you can resample images to achieve a variety of creative 
effects. If the Resample option is not available, Illustrator is able to detect the native resolution of 
the bitmap image. There are cases for which it might not be possible for Live Trace to determine 
the native resolution of the linked file (for example, if a placed-linked PDF file contains multiple 
images within it). If Live Trace can’t detect native resolution, resampling is selected and set to 
72 ppi by default. Additionally, placed-linked EPS files are sampled at 72 ppi when the Use Low 
Resolution Proxy for Linked EPS setting is selected in the File Handling & Clipboard panel of 
the Preferences dialog box.

Trace Settings
Live Trace can perform two types of vector tracing: fill and stroke. If Fills is selected, Live Trace 
creates closed and filled vector paths for all resulting vector objects. Fill tracing produces results 
that more closely match the original bitmap, including variable-width lines that are common in 
marker or ink sketches and photographic content. Fill tracing also results in more complex vec-
tors because it needs more anchor points.

If Strokes is selected, Live Trace creates stroked open paths for all areas that fall within the Max 
Stroke Weight setting. Areas that exceed this setting result in unfilled areas outlined with a 1-pt 
stroke. While Live Trace can apply different stroke widths to each path drawn, each path on its 
own can only contain one stroke width, making it difficult to trace lines of varying thicknesses. 
Stroke tracing results in less complex vectors with fewer anchor points.

The Strokes option activates two additional settings: Max Stroke Weight determines the heaviest 
stroke weight Live Trace can use in the traced vector result, and Min Stroke Length determines 
the shortest path Live Trace can use in the traced vector result.

Live Trace is also able to perform vector tracing using a combination of the Fills and Strokes 
tracing methods. If you select both Fills and Strokes, Live Trace converts the bitmap to a vector 
result using both stroked and filled paths.

1. The original bitmap image. 2. Fill tracing. 3. Stroke tracing. 4. Fill and Stroke tracing.

Path Fitting determines how closely the Live Trace vector result resembles the original bitmap 
image. A lower Path Fitting setting results in paths that follow closely with the edges and bound-
aries within the bitmap image, yet might also reveal imperfections in the original or produce 
paths that aren’t perfectly clean or smooth. A higher setting produces smoother paths with fewer 
anchor points, but might not match up exactly with the bitmap image. Setting the view options 
to compare both the original bitmap and traced result can help you determine the best Path  
Fitting setting for each file.

1. The original image. 2. Path Fitting set to 1 pixel. 3. Path Fitting set to 3 pixels. 4. Path Fitting set to 10 pixels.
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Minimum Area defines the smallest areas that are traced. Corner Angle defines the sharpness of 
the angles used in the resulting vector objects. This setting is measured in degrees, not pixels. If 
you think of 0 degrees as perfectly flat and 180 degrees as perfectly sharp, anything sharper than 
the Corner Angle setting (the default is 20) is converted to a corner anchor point rather than a 
smooth anchor point. 

Saving your own presets
Live Trace provides the option to define and save presets of settings that you use often. To create 
your own custom preset, click Save Preset in the Trace Options dialog box, name your preset, 
and click OK. Alternatively, you can choose Edit > Tracing Presets to create, edit, delete, and 
import or export Live Trace presets.

Live Trace presets are stored in a file named Tracing Presets in the Presets folder, located in the 
Illustrator application folder. You can distribute this file cross-platform among co-workers and 
colleagues. The following settings are not stored in a Live Trace preset: resample, the raster and 
vector view settings, and custom color libraries.

Using Edit Original with Photoshop CS2
One of the benefits of using placed-linked images with Live Trace is the ability to use the Edit 
Original feature, which enables you to easily edit the placed-linked image in a professional image 
editor, such as Photoshop CS2.

Even though Live Trace can perform bitmap conditioning, at times it might be beneficial to 
perform more advanced edits on the bitmap image to achieve better tracing results. For example, 
Photoshop has the ability to apply different settings or filters to portions of an image (Illustrator 
features apply to an entire image as a whole). In Photoshop, you can use the Paintbrush tool to 
edit local parts of the file and make minute changes in image makeup or structure. The Photo-
shop Crop tool can also remove parts of an image that aren’t needed.

With a Live Trace object selected, click Edit Original in the Control palette. The image opens  
in Photoshop. When you are done editing it, save the image and close the file. When you return  
to your Illustrator document, a message alerts you that the image has been modified and offers  
to update the file, at which time the Live Trace object updates with the new tracing result. In  
the File Handling & Clipboard panel of Preferences, you can have Illustrator update modified 
images automatically.

Setting Illustrator to automatically update modified links.

Photoshop also has several filters that can help reduce noise or enhance an image for better trac-
ing results. For example, you can use the Median, Smart Blur, and Reduce Noise filters to remove 
artifacts from images. Running these filters repeatedly with minimal settings usually produces 
good results. Adjusting the contrast of a bitmap using Levels or Curves, and using the Histogram 
palette to preview contrast and tone, can help define color boundaries and thicken thin lines 
that might not appear in the traced result. Additionally, a variety of tools, such as Dodge, Burn, 
Brush, and Eraser, can enhance parts of a bitmap image.



Batch processing
In workflows where multiple images require vector tracing, you can use a workflow script found 
in Adobe Bridge to automate the process. In Illustrator CS2, select Go to Bridge in the Control 
palette. After you have selected the images to trace in Adobe Bridge, choose Tools > Illustrator >  
Live Trace. You can then choose a Live Trace preset and a destination folder. The script can 
process up to 10 files at once. If you don’t have Illustrator running when you first run the script, 
you’ll have to run the script a second time.

Live Trace in action
Sometimes, a picture speaks louder than words. This section demonstrates how the different Live 
Trace settings can affect the final result.

Centerline tracing—A high-quality map can be created easily using the Stroke tracing option.

This abstract design was created by rasterizing a gradient mesh (right) and then applying the Photo High Fidelity 
Live Trace preset.

Live Trace for programmers
Illustrator features extended support for automation via scripting. With support for AppleScript 
on Mac OS and VB Scripting on Microsoft Windows, developers can take advantage of creating 
time-saving scripts for repetitive tasks. Additionally, Illustrator has robust support for Extend-
Script, an Adobe language based on the JavaScript standard. Adobe Creative Suite 2 ships with 
the ExtendScript Toolkit, which enables developers to write scripts, check syntax, and perform 
testing in an innovative and pleasing enviroment.

The Live Trace feature is scriptable, and you can create your own scripts to perform customized 
tasks. You can use the Live Trace batch script included in Adobe Bridge as an example of how 
you might enhance workflows using scripts with Live Trace.

For more information
For additional information about the features in Adobe Illustrator CS2, go to  
www.adobe.com/products/illustrator.
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